MoCo™ SMS Suite

Quick Guide for Clinics
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Chapter 1: Introduction

1.1 Purpose

The purpose of this document is to provide a Quide Guide for customers who are using MoCo in dental /
specialist / medical clinics.

1.2 Target Audience

The target audiences of this document are all clinic operators in the dental / specialist / medical sector.



Chapter 2: Patient Database Management
2.1 Import existing patient database

You can import your existing patient information into MoCo’s Address Book. The import file can be either in
csv (comma-separated-values) format, or a tab-delimited file, or a MS Excel file (*.xIs).

2.1.1 Prepare Import File (csv/txt) from existing database

To prepare import file from your existing Microsoft Excel spreadsheet,
Step 1: Open your patient database spreadsheet using MS Excel.
Step 2: From the File menu, select “Save As ...” option.

Step 3: A “Save As” dialog box will appear.
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2 |Foo Chee Yong 4659 Save ks EJE‘
EiDuriel Chua 2 Savein: WoCo Testfied v @ 3@ X Btk
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i > ) mport Adr book .15+
1| Deskiop | el Import A book S.csv
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Step 4: Key in the file name to be saved and select the type of file to be saved. For csv file, select “CSV
(comma-delimited) (*.csv)” as the file type. For tab-delimited file, select “Text (Tab-delimited) (*.txt)” as the
file type.

Step 5: Click “Save” button. The below warning box may appear. Just click “Yes” button.

Microsoft Excel

Export Addr bookl.csv may contain Features that are nok compatible with 5V (Comma delimited). Do you want to kesp the workbook in this Format?

\l) o Tl s e, wieh e e ey e s, 2 s,
« Tas preserve the feabures, cick Mo, Then save a copy in the lakest Excel Format.
+ Tou s st might bes loet, click Holp.

(=] [ ] e ]

Step 6: The csv / txt file is saved successfully. Close the MS Excel application.



2.1.2 Prepare Import File (MS Excel) from existing database

To directly import the address book from a MS Excel sheet, you need to convert the “Mobile Number” field
(and whatever number fields you have in your database) into a Text field:

Step 1: Open the existing excel file using Microsoft Excel. A sample of the excel file is shown below:

| A | B | = | D | E | F
1 [Mame Raw Mobile  |Address DOE Gender Group
2 |Chee Yaong 91112222 Blk 23 Fotong Pasir #04-05 11/14/1975 Male Member
3 |CEL 592221111 123 Eunos Road /201572 Male Mon-member
4 |Dennis 92223333 Blk 3 Geylang Road #01-234 11121975 Male Mernber

Step 2: Convert column B (“Raw Mobile”) into TEXT:

2a. Highlight the column (in this case, column B) to be converted.

2b. Select from menu, “Data -> Text to Columns ...” option.

2c. The dialog box shown below will be displayed. Click the “Next” button.

Convert Text to Columns Wizard - Step 1 of 3 El@

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Mext, or choose the data type that best describes your data.
Criginal data bype
Choo:

type that best describes your data:
- Characters such as commas or tabs separate each field,
th - Fields are aligned in columns with spaces betwesn sach field.

Preview of selected data:

[1 Faw Mobile 5

(2 plilzzzz

[z tesszzzi111

|4 p2223333

[E P3334444d R
-

2d. The dialog box shown below will be displayed. Click the “Next” button again.

Convert Text to Columns Wizard - Step 2 of 3

This screen lets vou set the delimiters your daka contains, You can see
hows your text is affected in the preview below,

Delimiters [] Treat consecutive delimiters as one
Tab [ semicalon [ comma o el
[Clspace  [Clother: || Text gualifier: | |

Data preview

[Paw Mobile i
blilzzzz

hesszzziill

bzzzazas

bzzzaa44 E

[ Cancel ][ < Back, ] Mext = |[ Einish ]

2e. The dialog box shown below will be displayed. Select “Text” and click “Finish” button.



Convert Text to Columns Wizard - Step 3 of 3

This screen lets wou select each colurmn and set Column data Format
the Daka Format, O General

‘General' converts numeric walues to numbers, date
walues o dates, and all remaining walues to bexk, | |
* & ) Date:  |MDY e

() Do not import column (skipd

Craka preview

Destination: | $B41 &

Cancel < Back Finish
[ J(

2.1.3 Configure type of Import file

Before importing the Address Book, you need to select the type of import file that MoCo needs to import.
Step 1: At the MoCo software, select “Configuration Settings”. A dialog box as shown below will appear.

Configuration Settings @

Basic 5 Address Book
General

¥ Auto-insert Area Code
Scheduler
Appaintment Book. Area Code to be autodinserted - |[+69
Device
G5M Terminal

Default SMS Subscription

& By default, subscribe to SHS

" By defaul, do not subscribe to SMS

Diefault Import Address Book Delimiter

Farmat for imparting address book : M5 Encel -
SpreadSheet Mame : Shestl %

Duplication Checl,

[ Enable Duplication Check when adding/updating contacts

Step 2: Under “Format for importing address book”, select the type of import file you are going to import into
MoCo’s address book. For MS Excel file, you will need to specify the SpreadSheet name also.

Step 3: Click “OK” button.

2.1.4 Import csv/txt/excel file into MoCo

To import from csv file into address book,
Step 1: From the File menu, click on the Import Address Book

Step 2: From the Open dialog box, select the csv or txt file to import into the database. Click “Open” button.



apen @5
Look in: |19 MoCo TestBed = cr E-
Y " Export Addr b v
B ) EL)Excport. Addr book.csv
My Riscent E=E] trnport Addr book 1.csw
Documents |EL} import Addr book 2.csw
T Bk trnport Addr book 3.csw
Bk Tt Addr book 4.csv
Desktop Bk Import Addr book S.csv
E=E] trnport Addr book 6.csw
/’-, ) Import Addr book 7.csw
My Documents
My Compiter
i} File name: [Esport Addr bookT.csv =l Open
=
My Network Files of type [ Comma Separated Values Files [~.csv) =] Cancel
Flaces
I~ Dpen as read-only

Step 3: On the Import Address Book dialog, match and select the correct field of each column. If you do not
select a field name above the column, that particular column will not be imported.

x]

Import Address Book

Impart pracess completed

Mame j Mobile: Number j MRIC

Dennis Chang +6591151254 S701Z2345A

Foo Chee Yong +E596955152 571234366 Friends
Daniel Chua +5598465863 S7234567C Friends
Eric Boo +6581983951 973456780

Chang Cheow Joo +6581239211 S7456789E

Hark Loong +6598268922 S7S67390F

Kahshin +6593625065 STEFEO1ZG

Mun Kiat +6597429045 S7TEO123H

‘wilzon Chia +6596585045 STE912341

< >

|mpart Cancel

Step 4: If one of the column of your database contains the name of the contact group, you can select the option
“Contact Group” for that column. For contacts who are members of multiple contact groups, the contact group
names are separated by semicolons within the column.

Mabile Mumber ﬂ MRIC ﬂ Contact Group
+6591151254 S701Z23454

+6596955152 571234366 Friends;Class &
+65235465663 S72I4567C Friends;
+6581953951 573456780 Friends;Class B
+6561239211 S7456F89E

+6508268022 S7SETE90F

+6593625065 S7ETEI12G

+6597429045 SFTE9123H

+B596555046 578912341

Step 5: Click Import button to start importing.

Step 6: A dialog box as shown below will appear, displaying the contacts that are imported successfully and
those that failed.

Import Result

- Passed C

X

Tatal number. 3

 Failed C

Total number: 0

Chang Cheow Joo
Dariel Chua
Deenris Chang
Eric Boo

Fao Chee Yong
Hark Loong
Kahshin

Mun Kiat

wilson Chia

Cantact Name

FReason of Failure

Save Result

Froceed Cancel

Step 7: To save result of the import process, click “Save Result”. The result is saved into a text document.



Step 8: To proceed with the import process, click “Proceed” button. To abort the import process, click “Cancel”
button.

2.2 Register new patient

To register new patient into MoCo, go to the Address Book page of MoCo.

Step 1: Click on = button to clear contact information area.

Step 2: Enter patient information into respective fields.

r Comtact Information

5701234548

123456

ale j
Movember 12, 1975

65554444

67775808

10 Anson Road #20-10

abc@hotrnail.com

|

 Members of

Step 3: Click on A to save contact information when done.

2.3 Printing Patient Labels

MoCo allows user to perform label printing on standard label type 1029.
To perform label printing, select “Print Label” from the File menu. A dialog box as shown below will appear.

Print Label x|

Select Conkack : i}

5 Chanc -
Type of Label : I Label Na, 1029 ;I oK
Positionin Label ———————— Cancel

i Left:
" Right

is Chang

Step 1. Select the contact who you wish to print the label of.
Step 2: Make sure the type of label is “Label No. 1029”.

Step 3: Select the position within label for printing. Click “OK”. The below Print dialog box will appear.



Princ 2]

— Printer

Mame: | Canon MP700 Printer =l Properties.

Status  Ready
Type Canon MP700 Printer
Whers:  USEOD2

Comment: [ Frint ta file

— Fint rang: Capi
& Al Number of copies =]
€ Pages  from: |1 tn'IT

s LRIl el
Help Eamee]

Step 4: Select the appropriate printer name. Click “Properties” button to set the paper size.

%% Canon MP700 Printer Properties 2x|

& Main % Page Setup | ®| Stamp/Background | s Effects | (3 Profiles | fi Mairtenance |

EF| Page Size [ - |
4+ Orisrtations & Portrait W L

0 28 Privter paperSize:. [Same v Page Size =l

Printing Type: | Homal-size Printing j

I™ Borderless Printing

R - 0|

. A5 ™ Duplex Printing
o

Nomaksize Printing Stagls Sids

= Longside stapling £ Shot-side stapling

Copies: 1 =] 1999)
™ Reverse Order
I¥ | Collate

R

Defaults
0K | Cancel | Hen |

Step 5: A dialog box as shown above will appear. Note that for different printer, a different kind of dialog will
appear.

Step 6: Go to Page Setup and set the Page Size to “A5”.
Step 7: Click “OK”. You will return to the previous Print dialog box.

Step 8: Click “OK” to proceed with the printing.



Chapter 3: Create Message Templates

MoCo’s Template Editor allows user to create reusable SMS messages. Frequently used SMS can be saved as
template and recalled when needed. User will be able to access the created template by right-clicking of the
mouse button in all “Message” text boxes, and then choosing from the options “Insert Template” or “Append
Template” to include a template into the message.

To create new templates,

& T T

Step 1: Click on ~|button to clear Template Information area.

Step 2: Enter template information (template name and content) into respective fields.

r Template |nformation

Template Mame : Patient Recal Template

Template Content - Hi <<Recipient Mame:>, it's time now! “rou are due for your routine checkup at
ABC clinic. Pleare call us at 6353535 for an appaintment,

[135 characters]

Al P

Step 3: Click on | to save template.

When a template is created successfully, the template name will appear on the List of Templates box.

3.1 Message Tags

MoCo supports the use of “Message Tags” for creating dynamic message content.

List of Templates -

r Template Information

Template Name : Test Template

Template Content Hi <<Recipient Name>>, please remember to come for your appointment at
<<Appt Daled, <<éppt Times). To confim, reply SMS “Confim ¢ chppt Delele
Name>>" - From ABC Dental Template:

Undo

B Update
ar Template
Copy
Faste
Delete = Clzar

167 characters] =1 Enlies
a Redipient's Name

Recipiert's Number ~ ——|
Originatar's Name

Criginatar's Number
Specfic Date
Specific Time
Appointment Date

You can insert message tags into templates by right-clicking of the mouse, and then select “Insert Message Tag”
to insert the appropriate message tags.

-10 -



Currently, MoCo supports the use of the following message tags:

Recipient’s Name — This tag shall be used to insert the name of individual recipients at the time of sending.

Recipient’s Number — This tag shall be used to insert the mobile phone number of individual recipients at
the time of sending.

Originator’s Name — This tag is only used in the “Forward to selected Recipients” action of the “Automatic
Response System”. It shall insert the name of the originator of SMS into the message.

Originator’s Number — This tag is only used in the “Forward to selected Recipients” action of the
“Automatic Response System”. It shall insert the mobile number of the originator of SMS into the message.
Specific Date — This tag is only used in the Scheduler. It shall insert the specific date of the scheduled SMS
sending into the message.

Specific Time — This tag is only used in the Scheduler. It shall insert the specific time of the scheduled SMS
sending into the message.

Appointment Date — This tag is only used in the Appointment Book. It shall insert the appointment date into
the message.

Appointment Time — This tag is only used in the Appointment Book. It shall insert the appointment time
into the message.

Appointment Name — This tag is only used in the Appointment Book. It shall insert the appointment name
into the message.

-11-



Chapter 4: Patient Regular Callback

MoCo can be used to perform patient callback on a regular basis for routine checkup.

4.1 Update patient’s last visit & recall date

After every appointment, the clinic’s operator shall update the patient’s last visit and recall date fields inside
MoCo Address Book. These information shall be used for patient recall.

Step 1: Select the patient to be updated from the List of Contacts.

Step 2: Key in the last visit (current date) and the recall date (say 6 months later).

— Contact Information

|

3f20/2007
Qf20/2007

L4

 Members of

Step 3: Click on ’gﬁl to save the changed information.

4.2 Perform patient recall

Patient recall can be performed every month. The key to performing patient recall is to retrieve the patients’
whose recall date is up and send out sms to them.

To perform recall on patients whose recall date is next month,

Step 1: From “Tools” menu, select “Send SMS” option. You can also click the & button on the toolbar
alternatively.

Step 2: A dialog box as shown below will appear. Type in the message you want to send in the message box
provided. The text on the left indicates the number of characters within the message. For “Normal Text”
message, one SMS allows 160 characters. For “Unicode (Chinese Text)” message, one SMS allows 70
characters. If the number of characters exceeds the limit, it shall be broken into multiple SMSes before sending
out.

-12 -



Send SMS

Recipients
Advanced

Messags

35 characters]

Message Type

This is the mes:

Mormal Text -

sage | want to

send,

Step 3: Alternatively, you can select from a list of message templates by right-clicking the mouse inside the
message box. A context box will appear. Move the mouse to “Insert Template” option to select a pre-defined

message template.

Message :

Message Type

Mormal Text

Undo

Cut
Copy
Paste
Delete

b
»

Test Template

Insert Template
Append Template

Insert Message Tag »

Step 4: Select the Message Type of the message you wish to send. If your message contains chinese text, you
must select “Unicode (Chinese Text)” option.

Step 5: Click the “Advanced” button.

Step 6: The “Advanced Recipient Selection” dialog box will appear. There are two ways of retrieving patients

whose recall date is up.

Method 1: Using “Recall Date” field

i~ #dvanced Search Criteria

Is within next month

Seach

Clear Criteria

-
-
-]
-
-
E
-]
;{

Method 2: Using “Last visit” and “Available for Recall” fields

~Advanced Search Criteria

¥ | Murnber of months before today j 5
¥ | Includes

Search ‘

4
=
&

Clear Critenia

=

O KN K K KR EN KN EN

Step 7: Upon clicking the “Search” button, the result shall be displayed on the lower portion of the dialog box.

-13-



Search Result

Name ‘ Muobile ... | NRIC ‘ User D | Gender

Diennis Chang +EEAT1.. 57012345 Select Al
Foo Ches Yang SE59ED.. 57124360 {T)
Dariel Chua 65904 SPZMEEIC Selected
Eric Boo +65819... 573456780 Contacts
ChangCheowJon  +65812., S74B6785E

Hark Loong SE5902.. S7SE7RA0F

Kahshin E5I35.. STETEIIZG Clear Entiizs
Mur et 574 SPTBIZH

Wiksan Chia 65968, 57891234

¢ s

Step 8: Click “Select All” button to select all the contacts retrieved from the search. You can also select a few of
the contacts by pressing “Ctrl” key and click on their individual names, then click “Selected Contacts” button.

Step 9: Click “Send” button to send the SMS.

Send SMS 3]
Send
Recipients Dennis Chang;Foo Chee Yong:Daniel Chua;Eric BooChang Cheow
Joo;Hark Loong:K.ahshinMun Kiatwilson Chia; Cancel
Advanced
Message : Hi <<Recipient Name:, it's time now! “rou are due far your routing

[135 characters] checkup at ABC clinic. Please call us at 5353535 far an appointment.

Message Type:  |Momal Test -

-14-



Chapter 5: Appointment Management
5.1 Setting up Auto Appt Confirmation

To set up MoCo for Automatic Appointment Confimation,

Step 1: At Auto Response System page, create a new rule:

r Rules Information:

Rule Name |Appt Canfirmation
r Condition
Sender
Sender ... HHALLER
Advanced ...

Meszage Pattern
Begins with ‘EUH[IHTI

[ Ends with ...

O Contans .; ‘

- Action

Action Type
Action Parameters

[JAuta Reply to Sender
[JFomward to selected Recipients Type of Message:
[Invoke External Application
[CAutamatic Shutdavn
[1Export to Text Document
[]5MS Subscription

Confirmation -

[ Iinformation Retisval

Set the sender condition to “All”, and message pattern to “Begin with: Confirm”.

Select the “Confirm/Cancel Appointment” action, with type of message set to “Confirmation”.

Click “Add New Rule” button to add the new rule.

5.2 Configure Appointment Book settings

To access the Configuration Settings dialog, click on the @ icon on the toolbar or select Configuration Settings
from the Tools menu.

Configuration Settings El
Basic ] Appointment Book
General
Address Book, Dretavl settings

Scheduler fppt Start Time: [09:00 == SMS Preferred Time . [10:30

Appointment Book

. ApptEnd Time (22200~

GSM Terminal
Enterprise Defaull SMS Reminder: [1 = [Daps = before appointment

Server Settings
D efault Priority Level : [ Medium =

Send subsequent SMS reminders

7 Send subsequent reminders inegardless of response

* Send subssquent reminders to confitmed recipients only
" Do not send reminders to confimed/cancelled recipients
¥ Automatically insert appointment name
Appointment name starts with :

"

Multiple &ppointment Book Configuration

Multi-ppt Book Configuration |

3 cancel |

-15 -



On the Appointment Book configuration page, users can configure the following default parameters:
o Default Settings
User can set the default values of :

Appointment Start / End Time

Preferred time to SMS

Date for SMS Reminder
Priority level

O O0O0O0

e Send Subsequent SMS Reminders

User can determine how MoCo handle subsequent SMS reminders:
0 Send subsequent reminders irregardless of response — Subsequent SMS reminders shall be
sent out no matter the recipients reply back or not

0 Send subsequent reminders to confirmed recipients only — Subsequent SMS reminders shall
only be sent out if the recipients confirmed their appointments (either manually or
automatically)

0 Do not send reminders to confirmed / cancelled recipients — Subsequent SMS reminders shall
not be sent out if the recipients has confirmed or cancelled their appointments (either manually
or automatically)

e Automatically insert appointment name

Upon creation of new appointment in the MoCo’s Appointment Book, an appointment name has to be
given. To auto fill the appointment name, check the box “Automatically Insert Appointment Name” and
type the name given to each appointment. MoCo will use this name and append a running number at the end
to make each appointment name unique.

e  Multiple Appointment Book Configuration

List of Appt Books:
Defavlt

Dr. Matthew Kan AppE Book Nams © Aok
Dr. Richard Pang |

Appointment Book Info

Appt Book Description :

Clear Entries

By clicking the “Multi-Appt Book Configuration” button, the above dialog box will appear for you to add /
delete / update appointment books.

5.3 Adding, Deleting and Updating Appointment
5.3.1 Add new Appointment

To add a new appointment,

Step 1: Select the Appointment Book within which you wish to add new appointment.
Appointment Book ——

|7S elect current Appt Book :

I

Dir. Richard Pang -

-16 -



Step 2: Double click on the screen calendar date that you want to create the appointment. A dialog box for
adding new appointment will appear.

Step 3: Enter information for the appointment.

Dr. Richard Pang Appointment Baok far March 21, 2007

Agporinert Hane:[31 " Pty [ Hedun - EEI:I AddNew
Subject [Ferria Chang Apporinent
Saan Time. |JU_ = Fanaks
Ered Temn [e =

W £M5 Reminder

Plecipients Dienri Chang:

Fuchewnd

—‘f tm;

7 13t SMS Ferinder =

Paiened Teoatoshis: [1090 = [T =] [Pwe =] baioes sppoiniment

Mexsage Content i <<Placiciant Hameys, you e o & Meage Type

[154 chmacsens) | wth 1 AL <t Dt o [omaTen —
¥ nd SMS Remnds

Pretomed Tme o 5is: [1030 = [0 @ Dy Views:

Metage Cantent Hi <:Fimepinn
1155 chamantens| cume ot

Jd 3M5 Peminder
[ =]

e Appointment Name - Appointment name will be used to confirm appointment when recipient reply with
SMS message.If the Config Setting for Automatically Insert Appointment Name is set, the appointment
name will be auto filled by MoCo.

e  Priority — You can select from low, medium, high and very high. This is only a color highlight for the
appointment subject when you look at the main calendar.

e Subject — A brief description of the appointment. The subject text will be displayed on the main calendar.

e Start / End Time — The appointment start and end time. Note that the appointment start time can be
automatically inserted into the SMS content using message tag <<Appt Time>>.

e Remarks — Additional (optional) remarks.

e SMS Reminder — Click this checkbox to enable sending of SMS reminder.

e Recipients/Advanced — Select the recipients for the appointment reminder SMS. You can select from a list
of contacts/contact groups (using Recipient button), or via querying the Address Book (using Advanced
button).

e 15/2"/3" SMS Reminder — Click this checkbox to enable sending of first/second/third SMS reminder.

o Preferred time to SMS — The preferred time to send out reminder SMS. You can set the number of
days/weeks before the actual appointment date to send the reminder sms.

o Message Type — Select from Normal Text, 8-Bit Data and Unicode (Chinese Text). For normal english sms,
choose Normal Text. For content containing chinese text, choose Unicode.

e Message Content — Actual message content to be sent. You can insert template or type in directly.

T AddNew

Step 4: Click on = to create appointment.

When an appointment is created successfully, the appointment’s start date, end date and subject will appear on
the main calendar.

-17 -



5.3.2 Delete Appointment

To delete an appointment,

Step 1: From the calender view, double click on the appointment entry to be deleted. Alternatively, from the
Appointment dialog, select the appointment to delete from List of Appointments.

T ot
Step 2: Click on ! to delete the highlight appointment.

5.3.3 Updating Appointment

To update an appointment,

Step 1: From the calender view, double click on the appointment entry to be updated. Alternatively, from the
Appointment dialog, select the appointment to update from List of Appointments.

Step 2: Replace the information to be updated.

1 Updste
£ Appointment

Step 3: Click on to save the changed information.

5.3.4 Changing Appointment Date

To change an appointment,

Step 1: From the calender view, double click on the appointment entry to be updated. Alternatively, from the
Appointment dialog, select the appointment you wish to change date of from the List of Appointments.

Step 2: Click on o el to change the appointment’s date.

Step 3: A dialog box shown below will appear. Enter the new Appointment Book name, Appointment Date,
Appointment Start and End Time. Then click “OK”.

Change Appointment Date

Appointment Book Mame : | Dr. Richard Pang LJ
Mew Appointment Date ; 10/30/2007 -
Skart Time : 0900 =

End Time : Zz:00 =
[0]4 | Cancel |

5.4 Check Response

To check a confirmation response,

Step 1: Double click on the appointment.

'ﬂ Fnsponsn
Step 2: Click on - | to open the response dialog. Check under the Response column for result.
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Response from Appointment Recipients El

Response Distribution

Confirm
B0.0%

Carcel NoResp
35.0% 25.0%

From | Mabile Number Received Response |

+E531181254 May 08, 2007 23 0347 Corfim
R e May 05, 2007 230327 Corfiim
Reply to Sender May 03, 2007 230333 Cancel

Dianiel Chua Ho Resporse

Confirm Appointment
Cancel Appaintment

Save Response

o HTHL Lhse

Upon right-clicking on the appointment recipient’s name, a context box appear displaying the following options:

e Reply to Sender — Select this option to invoke a dialog box for you to send sms reply to the sender.

e  Confirm Appointment — Do a manual appointment confirmation. This option is useful if the customer
confirm his appointment via phone call or other means instead of sms.

e Cancel Appointment — Do a manual appointment cancellation. This option is useful if the customer
cancel his appointment via phone call or other means instead of sms.

To save the response information into a HTML report, just click “Save Response to HTML” button.

5.4.1 Do manual Appt Confirmation at Transaction Manager

Received Status | Routs To | Ter
hdarch 20, 2007 11:16:31 oK ALL 5251

Forward message
Delete Records

Confirm/Cancel Appointment;

The following options are available when you right-click on any records in the Transaction Manager InBox:

e Reply to Sender — A dialog box will appear for you to send reply to the selected sender.

e Forward message — A dialog box will appear for you to forward the message to other recipients.

e Delete Records — Use this option to delete one or more records. Alternatively, you can use the “Delete” key
to perform deletion.

e Confirm / Cancel Appointment — A dialog box will appear, displaying a list of appointments of the sender.

Confirm / Cancel Appointment @

Select an Appaintment ko confim or cancel
Confirm

Appaintment

Date | Start Time | End Time | ApptBook | ApptMame | Subject

Cancel
Appointment

Clase
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To confirm/cancel any appointment, just click on the item and then click “Confirm Appointment” or
“Cancel Appointment” buttons. This feature is useful in updating the Appointment Book when customers
make appointment confirmation via phone call rather than sms.

5.5 View Appointment History

e
Appointment

Step 1: Click on == A dialog box will appear for you to view appointment history.

Step 2: Select the name of the contact. Click the Search button.

View Appointment History

Select Mame ;| Dennis chang - Search

¥ Search in SMs Recipient Export to File

¥ Search in Appointment's Subject: Cancel

Start Time | End Time | Appt Bock Appt Mame.
10:00 Dr. Richard Pang AL

Date ubject
21 March 2007 09:00

[ 5
Dennis Chang Appointment

Step 3: To save the appointment history to file, click “Export to File” button.

5.6 Import Appointment List

Import

Step 1: Click the - ™™™ |, An Open File dialog box will appear for you to load to Appointment list file. MoCo
expects a csv (comma-separated-values) file for importing appointment.

Open ]|
Lack in: [ 5 MolCa TestBed = « £ -

5 Bl Export Addr bookt .csw
\_u,ﬁ BllExport Addr book. csw
My Recent B impart Addr book 1.csv
Documents & rnort Addr book 2.cv
@ ) Import Addr book 3.csv

Bl Irnport Addr book 4.csv
Desktop ] Import Addr baok S.csv
Bl impart Addr bock 6.csv

__J Bl import Addr book 7.esv

—
-
58
My Computer
‘l‘] File name: ] =] Open
3

My Netwark  Files of type: [Comma Separated Values Files [*.csv) | Cancel
laces

I Dpen as read-only

A typical Appointment Import file (*.csv) should contain the following fields (not in any order):
e  Customer Name

Customer Mobile Number

Appointment Start Time (in 24-hour format HH:MM)

Appointment Book Name (Optional)

Appointment Duration in minutes (Optional)

All records within a single Appointment Import file should belong to the same appointment date. Each of these
fields shall be separated by a comma, and each record separated by a carriage return.

Step 2: Upon selecting the Appointment Import file (*.csv), a dialog box as shown below will appear, displaying
all the columns within the import file.
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Import Appointment: E‘

General Appoirtment Information
Recipient: Name j fippt Book Name j Recipient Makile Ha., j Appt Stark Time A
Appaintrient Date | 3/21/2007 ~| | orgen winum D, Richard Pang 96280000 "05:30"
Swee Fin Er Dr. Richard Pang 953520000 000"
Defaul Prary s |[] Medum he MarkKum Choon Woo Dr. Richard Pang 9461111 "9:a0”
Amy, Geok Huay Chia Dr, Richard Pang 91772222 000"
Duration (Minutes): |30 i =
Philip Chew Poa Tan Dr. Richard Pang 97543333 11230
Teng Phuan Ch Dr, Richard P: AT114444 "1z:00"
Preferred S Time : CRATENCI e
Kian Heng Chua Dr, Richard Pang SMH7S555 "13:00"
LRI ) 5' Days  v|before Appt. | | race Mei- EnLim O, Richard Pang 78S 100"
1 Gek Quek Dr, Richard Pang SESTTITT "14:30"
Message Typs ¢ Mormal Text hd Mong Siang Cng Dr. Richard Pang 91217324 "15:00"
Message Content  [154 characters] Choa Keaw Biao Dr. Richard Pang 98757777 16:00°
Choo keow Boon Dr, Richard Pang 9755005 "17i00" ]
Hi <<Recipient Mame>, you have an
appoirkment with us &t <<Appt Datex>, < >
<<Appk Time:» . To confirm, reply SMS with Inpart P L
"Confirm <<Appt Hame:>3", - ABC Dental | fearioceszten0cy i
mpar
| Ci\Temp J Sarve as Default
[V Save import pracess report Cancel

Step 3: Select the field names (Eg. Recipient Name, Appt. Book Name, etc) for the columns that you wish to
import.

Step 4: At the “General Appointment Information” portion on the left, enter the following information:

e Appointment Date — The appointment date for the appointments to be imported.

o Default Priority — Priority level of the appointments to be imported. You can use the default value.

e Duration — The appointment duration in minutes. If your appointment import file does not contain any
information on appointment duration, you can set a standard duration here for all the appointments to
be imported.

e Preferred SMS Time — The time and number of days/weeks before appointment which you wish to
send out SMS.

e Message Type — Select from Normal Text, 8-Bit Data or Unicode (Chinese Text). For normal english
content, use Normal Text. If content contains chinese characters, use Unicode.

e Message Content — The actual message content to be send out via SMS. You can insert template here
or key in the text directly.

Step 5: Under the “Import Process Logger” portion, you can save a report of the import process of checking
“Save import process report” checkbox. You can also specify the folder which you wish to save the import
process report.

Step 6: Once all the information are checked to be correct, you can click the “Import” button to proceed with the
import process. Upon successful import, you will see the below message box.

Import Appointment

.
\l) Appaintment imporked successfully!

5.7 Print Appointment List

MoCo allows user to perform print appointment list on standard A4 paper.

To perform appointment printing, select “Print Appointment Book™ from the File menu. A dialog box as shown
below will appear.
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Print Appointment Book ﬂ

Appointment Book hlame : I Dt, Matthew Kan, Dr. Richard Pang j Print
Starting Date : 19/03/2007 > Cancel
Ending Date : 23/03/2007 -

Priotity Level !

Low, Medium, High, Yery Hich

Step 1: Select the appointment book name which you wish to print.
Step 2: Select the starting/ending dates of appointments to print.
Step 3: Select the priority level of appointments to be printed.

Step 4: Click Print. A Print dialog box as shown below will appear.

Princ 21X
r— Printer
Mame: ICanUn tP700 Printer LI Properties... |

Status: Ready
Type: Canon MPF00 Frinter
“Wwihere:  USBEO02

Comment: ™ Pririt to file
— Print rang Copi
o« 4 Murnber of copies: |1 3:

£ Pages frnm'|1 tos |1

£ Selection Ijl
Help | Cancel |

Step 5: Select the appropriate printer name. Click “Properties” button to set the paper size.

=) Main 52 Page Setup | @) StampJEackgmundI P Effeclsl o5 F'lofilesl i Mainlenamcel
g Page Size: IAd j
D 4+ Orientation: &+ Portrait " Landscape
E Frinter Paper Size: ISamE a3 Page Size j

Printing Type: I Normal-size Printing j

I~ Borderless Printing

' ' i '
oot o Ederviers Mg ———— X
7 rmaunt of Extension J_

A4 i i [ Duplex Printing
Narmalsize Frinting Staple Side: & [ongside stapling. € Shortside stapling
Copies: |1 33 [1-939)

@ I Reverse Order
7 Collate

3
z
i
3
z
T

Diefaults
oK I Cancel | Help I

Step 6: A dialog box as shown above will appear. Note that for different printer, a different kind of dialog will
appear.

Step 7: Go to Page Setup and set the Page Size to “A4”.
Step 8: Click “OK”. You will return to the previous Print dialog box.

Step 9: Click “OK” to proceed with the printing.
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Chapter 6: Accounts System

MoCo has a built-in Accounts System for user to perform some simple accounting tasks.

To invoke the Accounts System, select “Accounts System” from the Tools menu. A dialog box as shown below

will appear.

Accounts System

X

rAccount Sheet
Display Options
PnE Ref. No, | pate [ client Name | Type [ Description | st paid | Pa
o Today's Transaction REFDO000004  August 07, 2007 13:32:10  Peter Tan Products  Something ABC 25.00 Ca
REFO0000004  August 07, 2007 13:32:10  Peter Tan Products  Something DEF 35.00 Za
" Current Month's Transaction REFOOO00004  August 07, 2007 13:32:10  Peter Tan Services Consultation & 30,00 Lot}
REFOOO0O004  August 0F, 2007 13:32:10  Peter Tan Services Consultation B 50.00 Ca
" Customized Period
Cther Options
Payment Type
all -
Account Type |
Products, Services > < | >
Aippi Bock Hame ; Morning Balance: | 0,00 Afternoon Balance: | 140,00 Night Balance: | 0,00
Dr Soh -
Total Balance: 140,00
Search i |
Memcggggé:‘ i #dd New Transaction Settings Save Accounts Sheet

6.1 Add New Transaction

Step 1: Click “Add New Transaction” button. A dialog boz as shown below will appear.

X

Add Accounts Record
Account Information
Reference Mo ! REFO000000S Assistant Name ! Eddy
Client [ Supplier : John Chan Remarks :
Payment Type : Cash
Appt Book ! Dr Sah w | Last Modified :
Type Description Amount Paid -~
Products | Product ABC 50
Services ¥ | Service ¥VZ 100
-
E I
v
-
-
e
-
Z v
Save Cancel

Step 2: Key in the accounts information. For expenses, you can add a minus sign in front of the Amount Paid
value.

Step 3: Click “Save” button to add the account.
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6.2 Manage existing account items

Ref. Mo, | Date | Client Mame Twpe | Description Amt Paid
REFOOOOO004  August 07, 2007 13:32:10  Peter Tan Products Sormething ABC 25.00
REFOOO00004  Augusk 07, 2007 13:32:10  Peter Tan Products Sornething DEF 35.00
e s e o 0 B = ) Services Consultation & 30.00
REFDOODOOOY  Modify 3:32:10  Peter Tan Services  Consulkation B 50,00

Delete

Print Receipk

To manage existing account item, right-click on the item and a context menu will appear for the following
options:

e Modify — Select this option to modify the information of the account item.

o Delete — Select this option to delete the account item.

e Print Receipt — Select this option to print receipt for this account item. Remember to set the paper size
as ‘Ab’.

6.3 Query Account System

Display Cptions
* Today's Transaction
7 Zurrent Month's Transaction

7 Customized Period

OEher Options

Payment Type @
= [=]|

Accounkt Type

| Producks, Services -

Appt Book Mame :

| Dr Soh -
Search

At the Display Options, select the query parameters and click “Search” button. The list of account items that
satisfy the query parameters will be displayed, together with the calculated balances.

6.4 Accounts Settings

se x|
Morning Timings : |12:DU AM j—1| @ |11:59 AM f—|
Afternoon Timings : [12:00PM = o [oSiSaPM
Night Tirings : osoop = [iiseem
Save | Cancel |

By clicking the Setttings button on the Accounts System dialog box, the above dialog box will appear. You can
set the individual timings and click Save button. The timings shall affect the calculations of individual balances.
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6.5 Save Accounts Sheet

By clicking the “Save Account Sheet” button on the Accounts System dialog box, you can save the currently
displayed account sheet to a HTML file.
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Chapter 7: Medication / X-Ray Records

MoCo has a built-in system for user to manage their medication/X-ray records. This feature is only available in
the version for dentist/specialist/medical clinics.

To invoke the Medication/X-Ray system, select “Medical/X-Ray Records” from the Tools menu. A dialog box
as shown below will appear.

Medication / X-Ray Records @

~Display Options -
Date | Patient Mame | MRIC | Type l Description ]

August 01, 2007 16:01:29  Dennis Chang 575343542 Medication  Erythromyein: 5, Amoxyeiling 3
August 01, 2007 16:53:59  Chee Yong 575343434 Medication  Metenamic Acid: 3, Metronidazale: 3

" Today's Records
" Current Manth's Record

7 Customized Period

Other Options

Record Type

Al -

Patient Name :

I—

Search
Manage Medication

Add Record or ¥-ray tem

7.1 Add Record

Step 1: Click “Add Record” button. A dialog boz as shown below will appear.

Add Medication / X-Ray Record f‘5__<J

Patient Harne ! | Danigl Chua j

NRIC ! 579576544
Type ! W Cancel

Save

Medication | ¥-Ray
Narne of Medication/X-Ray Quarniy Fi
Amaxyeilin LI 3
Chiorhexidine M _'_] 5
zl
-/
=l
5
=
M v

Step 2: Key in the record information.

Step 3: Click “Save” button to add the account.
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7.2 Manage existing records

Diate | Patienk Mame MRIC Tvpe Description
Augusk 01, 2007 Dennis Chang 575343542 Medication Erythromycin: 5, Amoxycillin: 3
August 01, 200 S 575343434 Medication Metenamic Acid: 3, Metronidazole: 3

Modify
Delete

To manage existing medication/X-ray record, right-click on the item and a context menu will appear for the
following options:

e Modify — Select this option to modify the information of the item.
o Delete — Select this option to delete the item.

7.3 Query System

Displayw Options

7 Todaw's Records
f* Current Month's Record
7 Customized Period

Dkher Options
Record Tyvpe
| &l =
Patient Mame :
| =1

Search

At the Display Options, select the query parameters and click “Search” button. The list of records that satisfy the
query parameters will be displayed.
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